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1. Overview

IPMI View (IPMI-Over-LAN) is a management software program based on the IPMI
specification Reversion 1.5 - 2.0. IPMI View sends IPMI messages to and from the
BMC (Base Management Card) on a host system at a remote location. IPMI
messages are encapsulated in RMCP (Remote Management Control Protocol)

packets called “datagrams.” This method is also referred to as “IPMI-over-LAN.”

According to the Distributed Management Task Force (DMTF) specification, RMCP is
used for system management in a pre-OS or an OS-absent environment. RMCP is a
simple request-response protocol that can be delivered using UDP (User Datagram
Protocol) datagrams. IPMI-over-LAN uses version 1 of the RMCP protocol and
packet format. An RMCP packet is transmitted via an IP (Internet Protocol) network,
which allows system managers to manage their IPMI-enabled systems over the
Internet. In a private LAN network, this is a basic feature. IPMI uses the same UDP
port number (623 in decimal) as the ASF (Alert Standard Forum) protocol. If the

managed system is protected by a firewall, UDP port 623 must be opened.

In Supermicro’s IPMI solution, a BMC (Baseboard Management Controller) shares
the LAN1 NIC on the mainboard. (If there are more than one LAN ports on the
mainboard, LAN1 is the one closest to the Keyboard/Mouse port.) The NIC will re-
route the IPMI packet to the BMC instead of forwarding it to the upper layer of the
network protocol stacks as other protocol packets do.

IPMI View V2.0 covers Supermicro’s BMCs for both IPMI v1.5 and IPMI v2.0.
However, due to design changes, some functions may not be available for IPMI v1.5,
while others might no longer be available for IPMI v2.0. IPMI View will automatically
hide any functions that are not available based on the BMC version used in the

system.
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2. System Management
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Figure 2-1

e Menu Bar: contains functions that allow you to add/delete systems or groups
and save configurations.

e Toolbar: contains functions that allow you to execute commands quickly. Click
the icons on the toolbar to add a new system, save the current configuration
settings, to discover IPMI devices, to access group management, to discontinue
the IPMI View section and to access the help menus. See Figure 2-2 for details.

e Logo: Click the Logo icon to visit Supermicro’s website.

e |PMI Sorting: This allows you to sort devices in ascending/descending order via
the online format, or in their original sequence.

e System List: This lists the computers managed by the BMC Controller.

e Group Management: This allows the user to manage system groups, including
creating/adding new accounts, deleting accounts and updating group

information.
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e Group List: This lists the computer groups managed by the BMC for better
management.

¢ Viewing Window: This shows detailed information including Login, IPMI Device,
Event Log, Sensors, BMC Settings, and the status of the IPMI View firmware.

o System View Sessions: IPMI View can manage up to 20 systems at any given
time. The systems that are currently managed by the BMC are indicated in the
System View window.

e Bottom Toolbar: This toolbar contains function tabs that allow you to execute
commands quickly. The tabs allow you to access the following submenus: Login,
Event Log, Sensors, IPMI Device, BMC Setting, Users, Text Console, and KVM

Console.

As shown in Figure 2-1, there are several components in the IPMI View window
(Figure 2-2):

T IPMI View ¥2.6.29 (build 070927) - Super Micto Compuier, Inc.
File Edit Manage Help

BEagife R
SUPERMICR®

IPMI Domain A % T & &

IPMI View

Intelligent Platform Management Interface

IPMI 2.0/1.5 over LAN

Figure 2-2

e ToolBar (Top)
The toolbar provides you with direct access to the features that are used frequently
(as shown in Figure 2-3). You are able to switch between server- and group-
management. The following toolbar shows the items that are currently available for

user configuration under BMC management.
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Add a new System
Save configuration
Discover IPMI device

Switch to server management
Switch to group management

BE agife R e

Close session

Show trap Info
About

Figure 2-3

e Adding a new system

Session  Manage Help
System

Discover IPMI Device Group

Reload Configuration

= |
Save Configuration CR.

IUpdate Firmware !

v g £t %

Language s ..
Exit

EJJ Mew System:

2 192 168.1.168

(=T 192.168.1.28

Figure 2-4

Click <File>"New>System” to add a new system to the IPMI connection (as shown
in Figure 2-4). An “Add a new system...” dialog box will display as shown in Figure
2-5.
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i Add a new system. . E| |E| rg|

System Mame:

IP sddress: | 0000 |

Description: | DESCRIPTION |

Figure 2-5

In the “Add a new system” dialog box, enter the System Name for the system to be

managed by the BMC, its IP address, and its description. Then click <OK>,

e Adding anew group
For better system management, the manager may group systems into different
groups. A system may be included in multiple groups. The default group is the “IPMI
Domain.” All systems under BMC management belong to the IPMI Domain even if

they are also added to other groups.

Click the menu: <File>"New...>Group” to add a new group to the IPMI connection.

An “Add a new group” dialog box will display as shown in Figure 2-6.

% Add a new gronp [Z| |E| E|

Group Name: | YRS T |

Deseription: | DESCRIPTION |

Figure 2-6

In the “Add a new group” dialog box, enter the Group Name and its description.

Then click <OK.>
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e Discover IPMI Device

IPMI View offers a feature that will detect all devices or systems currently connected
to the network. The user may specify a Network IP address range and network Mask,
then click <Detect> or <Start> to search for any IPMI devices or systems that are
connected to the IPMI 1.5 or IPMI 2.0 connections as shown in Figure 2-7. Click

<Exit> to discontinue this process.

£ JPMI Device Discovering

Metwork P From | [ERRISERIK]

To | 192.168.10.254

Metwark Mask | 255255 255.0

Search Option

[FIPMi20 []FM15

Start Exit

Faound: 2

P Mame “ersion
19216610241 [192.168.10.241 [IPhar 2,04 |
192 16610246 [192.168.10.245 IPr2.0 |

Figure 2-7

¢ Reload Configuration
From the pull-down menu, click <File>"Reload Configuration” to load the

configuration settings that were previously saved.

e Save Configuration
From the pull-down menu, click <File> “Save Configuration” to save the current
configuration settings.

e Update Firmware

From the pull-down menu, click <File> “Update Firmware,” and select the system you
wish to update from the IPMI Domain list on the left side of the window. A
Confirmation dialogue box will appear. Click <OK> to update the IPMI Firmware.

Click <Cancel> to discontinue this process.

From the pull-down menu, click “File>Save Configuration” to save the current IPMI

View configuration settings.
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e Language
From the pull-down menu, click <File> “Language” to activate a Language submenu.
From the submenu, you can select Chinese (Taiwan), Chinese (China) or English

(USA) as your IPMI language setting.

e Exit

From the pull-down menu, click <File> “Exit” or press <Alt-F4> to exit IPMI View.

e Modify System
Select a system in the System Window you want to modify and click <Edit> “Modify

System” to modify it from the pull-down menu as shown in Figure 2-8.

You can also right click on a system in the System Window and select “Maodify” in the

pop-up menu to modify it.

e Modify Group
Select a group in the Group Window you want to modify and click

“Edit>Modify...>Group” from the pull-down menu shown in Figure 2-8 to modify it.

You can also right click a group in the Group Window and select "Modify” in the pop-

up menu to modify it.
File Session  Mansge Hslp

MDdi.f}' ] & &
D gy S 2 ©
S IPHMI Security Group || 19216810

Join |ICR@®
Dizjoin _
Refresh ves %

Timeout ...

a) 103 169.10.242
m| 102.168.10.243

Figure 2-8

o Delete System
Select a system in the System Window you want to delete and click <Edit> "Delete

System” from the pull-down menu as shown in Figure 2-8 to delete it.
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You can also right click on a system in the System Window, and select “Delete” in the

pop-up menu to delete it.

e Delete Group
Select a group in the System Window you want to delete and click <Edit> "Delete
Group” from the pull-down menu to delete it as shown in Figure 2-8.

You can also right click a group in the System Window, and select “Delete” in the

pop-up menu to delete it.
e |PMI Security

From the pull-down menu, click <Edit>"IPMI Security” to activate the IPMI Security
dialogue box. Check Auto Detection for IPMI View to automatically check the current
IPMI status. Check the Advanced User box to select the following protocols as shown

in Figure 2-9.

¢ Hardware: BMCB, Firmware:IPMI 1.5:
e Hardware: BMC2, Firmware:IPMI 2.0 (hon-RMCP+):
* Hardware: BMC2, Firmware:IPMI 2.0 (Standard RMCP+).

Check the Encryption box to use encryption supported by the IPMI 2.0 Standard
RMCP+. All packets transmitted from IPMI View to the BMC system management will
be encrypted.

IPMI Protocol X

92 IFMI Protocol for Mew System

»\.__‘

() Auto Detection

For &dvanced User. Select Following Protocols based on Hw' and P!
(O Hw!: BMCE, P2 IPMI 1.5
I HA: BMC2, P P 2.0 non-RMCP+

(%) Hw: BMC2, Fw/: IPMI 2.0 Standard RMCP+

£
Hw = Hardware
Fwf = Firmware
Figure 2-9
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e Joinagroup
Select a group in the Group window, a system in the System Window, and click <Edit
“Join” from the pull-down menu to include (to join) this system into the group as

shown in Figure 2-8.

e Disjoin a System or a Group

Double click the group from which you want to disjoin a system. The systems that are
included in the group will appear in the System Window. Then, select the system you
want to disjoin from the group, and click <Edit> “Disjoin” from the pull-down menu
shown in Figure 2-8. You can also select a group from the Groups list and click
<Edit> “Disjoin” to remove it from the IPMI groups.

You can also right click the selected system, and select “Disjoin” in the pop-up menu

to remove it from the group.

e Refresh

Double click the group from which you want to disjoin a system. The systems that are
included in the group will appear in the System Window. Select the system you want
to refresh, and click <Edit> “Refresh” from the pull-down menu to refresh the system

as shown in Figure 2-8.

e Timeout

The timeout setting is shown in Figure 2-10. Timeout is the period for IPMI View to
wait for a response after sending a command to a managed system. If a response is
not received from the managed system in the timeout period, IPMI View will resend
the command to managed system again. You may specify the timeout value (in
seconds) to get a quicker response from the managed system. You can also specify
the number of times that IPMI View will resend the command.

Setting

9
</

Tirneout for retry [zecond] 2

Humber of retry 20

Figure 2-10
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e Section
IPMI View will display the IP address(es) currently connected to the network when

you click <Section> from the toolbar. You can disconnect the IPMI connection from a

Al 10 R 6N
Setting... | -
SUPERVIICR®
B PmiDoman  ~ v @ & %
[ Hew System
= 192.168.1.227
[=) Mew Systemz
[ 132 168.1.168
= 192.168.1.38
1PMI Vi
Intelligent Platform Management Interface
IPMI 2.0/1.5 over LAN
EEE

Figure 2-11

¢ IPMI View Management
IPMI View allows you to manage your server or your network group by selecting

<Manage> “Server/Group” from the pull-down menu as shown in Figure 2-11.

In addition, you can also configure Group Login Settings by selecting “Setting” from a
pull-down menu under the <Manage> tab. A dialog box will appear, prompting you for
the Login ID and Password. Once enter the values in these fields, click <OK> to
access the page and configure the settings. Please note that this feature is available

for the system administrator only.

e Help
Select <About> to display the information on the systems connected to the network.

10
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3. Login

e Login

Click the <Login> tab on the bottom toolbar as shown in Figure 3-1. A login screen
along with some information about the managed system will appear in the Viewing
Window. Enter the login ID and password, and click the <Login> button to log in.
When login is successful, the connection information will be shown at the bottom.
The Login button is grayed (disabled), and the Logout button as well as other

available management functions will be enabled. as shown in Figure 3-2.

Fie Edt Session Manage Melp
0magneqRé
B EACE]
SUPERMICR®
Av@ES
Syptem Name 19271681,
LogniD | ADMN
[] sarve 10 and Passwosd
[ Logn ]
Eﬁm Bddd
Login
[ Feady
Figure 3-1

07 IPMI View ¥2.6.29 (build DT0927) - Saper Micro Computer, Tnc.
File Edit Semion Maage Help

LERY-TTE XX
SUPERMICR® | ="

Syewen Mo 107716810341
1P Adwss 19216810241

Dexcption 192 168.10 241

LogilD | ADMIN
Faswund | =

] e D0 d Peusd

Logout

CONNECTED
Groups LEEE] ‘

I Dommain A}

Version : M1 20 ENCE

Cipder Sue | RAKT-HMAC-SHAL EMAC-SHAL-96, AES-CEC-129

Lagin | Bvet Log| S| T7M Dwvicn | BMC Satisng | Tomes | Tt Conre | KVM Connie | Vastoal Mdia

RMICRs (pen Seesicen snwemsdel

Figure 3-2
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The default Login ID and password are “ADMIN”. Both are case-sensitive.

In IPMI View, an MD5 algorithm will encrypt the password when it is transmitted
through the network. (If you are connecting to the IPMI 2.0 RMCP+, all the data will
be transmitted by an encrypted algorithm.) Once the password is confirmed, IPMI
View will show a CONNECTED symbol, and all available function pages will be
shown as in Figure 3-2. If the password is invalid, a message will be displayed in the
Status Area that reads, “Unable to activate a session, please check ID and

Password.” and a Break symbol will be shown (see Figure 3-3).

:j IPMI Yiew ¥2.6.20 (build 070927} - Saper Micro Compuier, Inc.
File Edit Session Manage Help

RIEIEYEEIEE

SU PERMICR® 192 168.10.241
avQ&EH

IPMI Domain

Svstemn Name  192.168.10.241
IP Address 192.168.10.241
Description  192.168.10.241

LoginID | admin

Passwond

save ID and Password

Login

BREAK
==l Groups EEE T
i TFI Dommedn (44
Login
RAEP Message 2 exvor: Unauthorized name (status code = 0Dh)
Figure 3-3

In order to reduce overhead on the managed system, all pages will not be refreshed

automatically. The user must refresh the pages manually as needed.

After logging in, the IPMI View main window will display as shown in Figure 3-2. A

tool bar will display on the bottom of the screen for your convenience.

12
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e Bottom ToolBar
As shown in Figure 2-4 below, this toolbar contains function tabs to allow you to
execute commands quickly. The tabs allow you to access the following submenus:
Login, Event Log, Sensors, IPMI Device, BMC Setting, Users, Text Console, KVM
Console.

Log

Event Log
Sensors

IPMIDevice i cetting

I
Login | Event Log 1 Sensurslj IFM Device BMC Setting ["Users|[ Test Console| KM Console]

UserJ

Text Console
KvM Console

Figure 3-4

13
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4. Event Log

After you have logged into a system, the screen as shown in Figure 4-1 will display.
Click the <Event Log> tab on the bottom toolbar to activate the Event Log screen as

shown in Figure 4-2.

Fle Bdit Zemion Muage Help

HE & Qi @ Q6
SUPERM]CR. I 19216000241

B P Domain A v O # G

Syt N 192168 10241

B

5 2
L) 152 16810 243

IF Mdeess 192168 10241

Descrighon 193 16810 241

LaginlD | ADMIN

[ e 1D and Pooword

[ romn |
CONNECTED
45 Ganups EXEX -
B [FMI Do (4A)
Yermon : IFMI 20 RMCPe
Cophae Zuiwe - RAKP-HMAC-ZHAL, HMAC-IHA 06, ARS-CRC- 135
Logis  EventLog | Sensoes | [FM Devce | BMC Sefing | Users| Trod Comole | KYM Comnole | Varton] Meda
FMCP4 Opem Serviom mccemfel
Figure 4-1
File Edit Session  Manmage Help
Bl A 3E @R 6
SUPE ICR. & 192166138
| System Event Log
M IPMIDomain & v & £ @
3 e SEL Version: 15
=) M @ 8l
= Total Ent
R otal Entries: 171
| New System? OFmam [T To 171 | Free Space: G820 bytes
=) 192.168.1.227 Recent Enty Added: 12/08/2009 16:44:49 Tue
i,JNewSystemT Get } I Export } Recent Entry Erased:  01/01/1970 00:00:00 Thu

Clear All Entries
Current SEL Device Timestamp: | 12,/09/2009 14:44:28 \Wed S TR

| Logiﬁ\ “EventLog:| Sensors | IPM Device | BMC Setting|| Users| Text Console | K\M Cansole|

Gt SEL Time succesdsd

Figure 4-2
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System Event Log

All: Click this radio button to select all events.

From...to: Click this radio box to select a portion of events.

Get: Click this tab to get the event logs.

Export: Click this tab to export event logs to a file.

Clear All Entries: Click this tab to clear all event log entries.

Current SEL Device Timestamp: This item displays the timestamp of the

current SEL device.

Set Timestamp: Click this tab to set the timestamp for the system selected.

Refresh: Click this tab to refresh this page.

15
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5. Sensors

This feature displays the status of each sensor used to monitor system health as

shown in Figure 5-1.

;j IPMI Yiew ¥2.9.18 (build 130410} - Snper Micro Computer, Inc.

Fil: Edit Session Manage Help

Bl A EEeRe

SUPERMICR. & 10.133.176.155 \

IPMI Domain =~ & + @ & &
g 17223 196230 -
R 10,132 176,19 p
= 101339961 == 1

FCORE WOIMM

10.133.176.155-1
) 10.133.176.170
& 10132176142 o
210133 176172

ommae
- —

) 10133 176152
) 10133 176.106
) 10.133.176.188

Z110.133.176.129 DC 12V Output Power

) 10133 17688 AC Input Fower

) 10133 176.160 :

1 10.133.176.107 GHNIEYEEE

3 - CPU Temp

101331601

=linizzireol

L [C————=usjC

P1-DIMMAT Temp P1-DIMMAZ Temp

Hide inactive item.
[] Show History

Refreshevery |60 semnds[ Refresh Now ]‘[ Sawe Layout ]

Login || Event Log| Sensors | TPM Device | BMC Setting | Users | Text Console | K¥M Console|

Refreshing sensors’ status completed

Figure 5-1

e [Fans: This window displays fan status.

e Voltages: This window displays voltage readings for various devices.

e Temperatures: This window displays temperature readings for various devices.

e Sensors: This window displays the devices being monitored.

e PSU: This window includes three tabs: PMBus, FRU, BBP (Battery Backup
Power). Click each tab to view the information.

e Refresh Every X seconds: Enter the number of seconds for the system to
refresh.

o Refresh Now: Click this button to refresh the Sensors page immediately.

e Save Layout: Click this button to save the current layout setting.

e Hide inactive item: Check this box to hide inactive items.

e Show History: Check this box to display the sensor records.

16
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5.1 Discharging Battery

1. The battery can be automatically or manually discharged. In the PSU dialog box

(see Figure 5-1), click the <BBP> tab.

-
i IPMI View V2.9.14 (build 121115) - Super Micro Computer, Inc.

File Edit Session Manage Help

DBAE0e R

19216823 119 | & 193.168.12.157

SUPERMICR® [ ==
IPMIDomain & ~ & £ 4 || [ PrBu: [ FRU| BBP
Tz s 2350
& 1021682391 S| e BBE 2 (Click Setting)
1971652793 b SUFERMICRO)
& 1921632394 Mode] Name PWS-2065-1R)
& 19716823 98 | {eriet Framber P20GBYCANB WL 37
| =) 192 168.23.100 Froduct Version 12
& 192.163.23.101 Finmware version 10
) 192.168.23.104 |Batery Valtage oy
& 192.163.23.105 Battery Cumrent 257 &
= 19216923108 Battery Pack Temp 32‘@]
| ) 192 168.23.108 Fower Watings 2009
& 10216823112 I | ycte Count E
& 197168.23.157 | | Battery Fower Siatus Nommal
i) 10.150.55.28 100
&) 172.22.195.230 fus e
Discharge Setting Auta (21 days)
Disshargs Remaining Days M ax
Battry Status # 0:I0ED)
D) 1723117140 Befiery Stns [FULLY CHARGED][DISCHARGING]
) 1723117148 B

& 192168.12.137
=

Hide insstive item

Refreshevery |60~ seconds | Refresh How
! 7] Show History

Login | EventLog| Sensors | IPM Device BMCSemg|Users|TemComole|KVMComo1e\

Refreshing sensors' status completed

Figure 5-2

2. Click the top right field BBP2. A dialog box appears.

& - —
Battery Discharge Setting - u

Dischares
@ User (Will discharge immediately)
e  —

Figure 5-3

3. Select <Auto> and type desired number of days for the battery to discharge

automatically, or select <User> to manually discharge the battery. Click <Update> to

start.

17
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6. IPM Devices

Click the IPM Device tab of the IPMI View management session in the Viewing

Window (shown in Figure 6-1) to display the information and functionality of the BMC

firmware installed in the system.

:: TPMI View ¥2 918 (build 130410} - Supexr Micro Compuier, Inc_
File Edit Sesson Manage Help

e agde R
SUPERMICR® | = """

il 1PMI Domain Py Device Infarmation

&l 17223196 220 ~ Firmyrare Revision 1.05 ACPI Systern Power State S0/30
&) IPMI Revision 2.0

On

Graceful Power Caontrol

REJFg=iiul ) Sritiefanym

Chaszsis Power Control
=) 10.133.176.172

1 10.133.176.152
=1 10.133.176.106
2 10133.175.168
=l 10133.176.139
=l 10.132.176.88

L cowendsnwn Il EOWERNE ) Eowerieycle i IZEset |

ﬁ 10.132.176.160 BhC LD LEDY Fan Speed Mode
) 10.133.176.107 - (&) Standard () Optimal
= Cold Resst Blink UID LED Update
1 10.133.160.1 - hakicics O Full
i
= 101 179581 OHeavyIO

Login || EventLog | Bensors| IPM Device |EMC Setting | Users| Test Console | KV Console

et ACPI Power State succeeded

Figure 6-1

e Device Information

This shows the revision levels of the BMC and IPMI firmware.

e ACPI System Power State

This shows the power state of the managed system. If the managed system is in a
power-off state, the green light will be off. It will be updated automatically every five
seconds.

o Graceful Power Control (Administrator and Operator only)
Graceful shutdown will inform the OS running on the managed system to

shutdown within a specified time. When the OS running on the managed

18
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system receives a graceful shutdown request, it will start to shutdown system.
This behavior is via ACPI by emulating a fatal over temperature.
e Graceful Shutdown: This feature has the same function as “shutdown” in the

Windows. Using this feature will cause the managed system to enter the S5 state.

e Power On Icon: Click on the Power-On icon to power on or power off the device.

e Chassis Power Control (Available for the Administrator and Operator only)
This feature is used to manually control the power state of the chassis of a managed
system. When the BMC receives the power control command from the chassis, it will

have direct control over the power button or the reset button of a system.

o Power Down: This feature will power off a managed system as it would when the

Power-Down button of the chassis is pressed.

e Power Up: This feature will turn on the power of a managed system as it would

when the Power-Up button of the chassis is pressed.

e Power Cycle: This feature will turn off the power of a managed system for a few

seconds and then turn on the power of the system again.

o Reset: This feature resets a managed system as it would when the Reset button

of the chassis is pressed.

e BMC Cold Reset (for the Administrator only)

Clicking the Cold Reset button allows you to reset the BMC. After confirming the
reset of the BMC, the session will be terminated immediately. The user has to close
this session manually. This feature is rarely used. It is only used for an event when

you suspect a system malfunction for example.

e UID (Unit Identifier) LED
¢ Blink UID LED: Click this table for the UID LED to blink when the unit in

guestion is identified.

e Refresh
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Click this tab to refresh this page.

e Fan Speed Mode
Select the desired fan speed mode and click Update. Note that available speed

options vary.
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/. BMC Settings

(Available for the Administrator only)

Click the BMC Setting tab of the IPMI View management session in the Viewing
Window (as shown in Figure 7-1) to display detailed information on the BMC LAN
Configuration, SNMP trap configuration and the serial port status.

BMC LAN Configuration
pane [0 ] s ]
Subnet Mask |:| LAN MAC must be corect while update
=
SHMP
—
SMMP Trap Receivers IP Lddress
0.0.0.0 ~
0.0.0.0
0.0.0.0
0.0.0.0
0.0.0.0 &
LAN Interface
) Dedicated ) On Bosrd LAN (&) Failover
Login | Event Log || Sensors | IPM Device | EMC Seth_ng| Tsers | Text Console | KVM Console

Figure 7-1

e BMC LAN Configuration

This feature displays the IP address, the LAN MAC, the Gateway IP, the Gateway
MAC and the Subnet Mask of the BMC and allows you to modify these settings.
NOTE: please make sure that the MAC address of the LAN and the gateway for the
BMC are correct before updating it by clicking the <Update> button. Be careful to
enter the correct values especially for the LAN MAC. If you enter the wrong LAN

MAC, IPMI View will not be able to connect to that system any more.
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If you accidentally enter a wrong LAN MAC value, you may use the IPnMAC.exe
command in the IPMI Solution/Utility subfolder on this CD to update it. To activate
IPNMAC.exe.,which is a DOS command, you must first boot your managed system to
DOS, and then execute IPNMAC.exe on the managed system. You can also enable
the VLAN (Virtual LAN) Tag setting by clicking on the “Enable VLAN Tagging” box on
the right and enter the value on the VLAN Tag field to configure VLAN Tag setting.

e SNMP

This displays the SNMP trap configuration of the system that needs to receive the

SNMP traps generated by the BMC to allow you to modify the settings. To change

the configuration on the BMC, enter the SNMP community name in the Community
text field, and enter the IP address as well as the MAC address in the SNMP Trap

Receivers table in the SNMP group. Then, click the <Update> button.

The SNMP Trap may have multiple destinations. When any critical error occurs, an
SNMP trap packet will be sent to all receivers in the list. To remove an SNMP
receiver, you may change both IP and MAC addresses to 0.0.0.0 and
00:00:00:00:00:00 respectively. Then, click <Update>.

For a system to receive the SNMP traps, you must install and run an SNMP trap
receiver program. The managed system will send out an SNMP trap packet to all
receivers when an event occurs. If an SNMP trap receiver is not running, the trap

packet is discarded, and cannot be queued anywhere.

e RS232/MODEM (available for IPMI 1.5 only)
This displays the configuration of the RS232 interface on the BMC. It is used to
initialize the RS232 port and the installed modem, if any. The RS232 port is the box-
header (Figure 7-2) on the BMC, and a dedicated serial port.
* Baud Rate: It is the baud rate for serial connections, which will not affect
paging settings.
* Modem Init String: This is the modem initialization string for serial link

connections, which will not affect paging settings.
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Figure 7-2

LAN Interface

Dedicated: Click this radio box to use the IPMI-Dedicated LAN as the default
LAN connection.

Onboard LANZ1: Click this radio box to use the onboard LAN port 1 as the
default LAN connection.

Failover: Click this radio box to enable Failover support.

Update: Click this tab to update LAN connection status.

Refresh: Click this tab to refresh the page.
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8. Users
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Figure 8-1 (For IPMI 2.0)
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Click the Users tab of the IPMI View management session in the Viewing Window (as

shown in Figure 8-1 and 8-2) to display detailed information on the Users

management, and paging severity thresholds for IPMI 1.5.

We strongly recommend that you change the password immediately for

securnyreasons.

USERS
* User Name
IPMI View allows you to add or delete a user, to change a user’s password, to set

and update user privilege settings by clicking the appropriate tabs.

* Privilege

This feature allows you to set and update privilege level for a user or delete a
user from the list. There are six privilege levels, Callback, User, Operator,
Administrator, OEM, and No Access. Only the first four privileges are supported.
Privilege Levels determine which IPMI commands a user can execute over a
channel. Privilege Limits set the maximum privilege level that a user is allowed to
operate at. A user is granted certain privileges for each channel, and the user can

operate at a privilege level that is granted. Click the “Update Privilege” to change

the privilege level setting for a user.

Group Privilege Levels

Callback

This may be the lowest privilege level. Only those commands that
are used to initiate a Callback are allowed. (Available for IPMI 1.5

only.)

User

Only the basic commands are allowed. These commands are used
to read and retrieve data, to modify BMC configuration settings, or to
write data to the BMC or other controllers. Actions such as resets,
power on/off, and watchdog activation are not allowed.

Operator

All BMC commands are allowed, except for commands that can
modify out-of-band interface settings. For example, the Operator is
not allowed to disable individual channels or change a user’s access
privileges.

Administrator

All BMC commands are allowed, including modifying commands. An
Administrator is allowed to execute configuration commands that
disables the channel over which the Administrator is communicating.
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e SOL (Serial-Over-LAN)
This feature allows the user to configure SOL settings. Click “Enable” to
enable SOL support. Click “Update SOL Privilege” to update a user's SOL

privilege level.

Click Paging Setting to set the parameters for an individual user (Figure 8-3).
There are two types of paging services: Numeric paging and alphanumeric
paging. To use a paging service, a modem must be connected to the RS232

connector on the BMC (Figure 7-2).

& Paging Sethng

User Mame | g

Fager Mode

Paging Service Mumber 09125051 32

Mutneric Message | SOOERH

Macetn Init String | ATLA M1 X3S5=2E

Dial String | ATDT

Update ” Cancel ” Test Paging

Figure 8-3

e FRU (for IPMI 2.0 only)

This provides useful information on the board and the product, including the serial
number, part number, and the components of the motherboard. Click the “Update
FRU” tab to update board information and product information, including information
on the manufacturer, the name of firmware, the serial number/ the part number of the
motherboard, and the part/model number of the BMC firmware, the version and the
serial of the IPMI/BMC firmware.
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e PAGING/SEVERITY (for IPMI 1.5 only)

Use paging severity settings to determine when a user will be notified of an entry of

the system event log (SEL).

The following settings are available for each group:

None When this setting is selected, user notification for this group is disabled.

Warning When this setting is selected, the RMC will notify the user when SEL
entries for the group exceed the warning thresholds.

Critical When this setting is selected, the RMC will notify the user when SEL
entries for the group exceed the critical thresholds.

All When this is selected, the RMC will notify the user of all entries of the

SEL events for the group.

All warning and critical thresholds are predefined by Supermicro based on hardware

design.
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9. Text Console Redirection
(SOL- Serial-Over-LAN)
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Figure 9-1

Click the <Text Console> tab on the bottom tool box (shown in Figure 9-1) to enable
Text Console Redirection support, which will allow you to control a remote system
from a text mode console. Click the <Start> button to start the text console

redirection. Click the <Stop> button to stop the text console.

® BMC for IPMI 1.5

Console Redirection is not supported by the IPMI specification V1.5. Supermicro
provides this useful feature for a manager to control the managed system from a
remote location. When a managed system is booting up during the POST routine,

and no other software application are available for you so that you can gain control
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over console redirection, IPMI View provides you with this valuable feature. Console
Redirection will redirect the monitor of a managed system for IPMI View use and

allows you to send the key codes to the managed system.

When a managed system changes its video mode from Text Mode to Graphics Mode,
a termination notice will be sent to IPMI View to terminate the console redirection.

Text Console Redirection only works with the text mode.

Important Note: Console Redirection can cast a very heavy load on a managed
system. It will redirect the whole monitor to the manager’s system, and it will slow
down the managed system significantly. We suggest that you use this function only
when you absolutely need it. For other applications, a proper console redirection
software application (pcAnywhere, Symantec Corporation) or a remote login protocol
(telnet) is recommended. When you finish your remote operation, click <Stop> to

terminate console redirection to take the load off the managed system.

® BMC for IPMI 2.0

Serial-Over-LAN (SOL) was designed to support Text Console Redirection based on
the IPMI specification V2.0. This function performs better in IPMI 2.0 than in IPMI 1.5.
The Text mode console is supported by the Windows 2003, even when the OS is
running. To support Text Console Redirection on the Windows 2003, Special
Administration Console (SAC) must be enabled. The following instructions are used
to enable the SAC:

1. Enable Console Redirection in the BIOS, and set it to COM 2 (or COM B)

2. Modify boot.ini in C:\. Boot.ini is a hidden file. An example of boot.ini is listed

below.

[boot loader]

redirect=com2

redirectbaudrate=19200

timeout=30

default=multi(0)disk(0)rdisk(0)partition(L)\WINDOWS

[operating systems]

multi(0)disk(0)rdisk(0)partition(L\WINDOWS="Windows Server 2003, Standard"

[fastdetect /redirect
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To enable Text Console Redirection support on a Linux Platform:
1. Host A with the IPMI BMC installed (for the Linux Platform):

a) BIOS POST:
(i) Enable "Console Redirection” in BIOS Setup.
For example, COM2 / 19.2Kbps / 8N1

(ii) Disable "Enable Console Redirection after POST" in the BIOS setup.

b) Boot Loader:
(i) For GRUB,
add the following TWO lines into /boot/grub/grub.conf, but
comment out "splashimage=(hd0,0)/grub/splash.xpm.gz"
serial --unit=1 --speed=19200 --word=8 --parity=no --stop=1
terminal --timeout=10 serial console

#splashimage=(hd0,0)/grub/splash.xpm.gz

(i) Then add "serial console=ttyS1,19200n8" to the end of kernel /vmlinuz in

/boot/grub/grub.conf.
For example:
kernel /vmlinuz-2.6.5-1.358smp ro root=LABEL=/ rhgb quiet serial
console=ttyS1,19200n8
This will result in all boot messages being output to the console ttyS1, but

you will not see
All these boot messages on the local console until the login message

prompts.
c) LINUX OS:
(i) Add the following line into /etc/inittab.
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s0:2345:respawn:/shin/agetty ttyS1 19200
(i) Edit /etc/securetty and add ttyS1
2. Host B with IPMI View installed:
a) Install and run IPMI View.
b) Log in Host A with the IPMI BMC installed as Admin.
c¢) Start Console Redirection in IPMI View immediately after the Host A

reboots.

You will see the BIOS POST, the boot loader, and the Linux OS messages

and prompts.
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10. KVM Console (KVM-Over-IP

for Video Redirection)

KVM Console Redirection is a new feature included in the Supermicro Intelligent
Management (SIM) Module. If Video Console Redirection support is enabled, the
remote screen will be redirected to IPMI View. BIOS POST, BIOS settings, DOS,

Windows or Linux OS screens can all be redirected to IPMI View.
Click the <Launch KVM Console> tab to launch KVM console redirection.
Figure 10-1 shows sample screenshots of Video Console redirection. The screen of a

remote managed system will be redirected to IPMI View. You will see the screen of

the remote system just as if you were sitting in front of the system.

O] IPMI Yiew ¥2.5 Beta(build 060522) - Super Micro Computer, Inc.
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Figure 10-1-1
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Toolbar

There are several tool buttons that can be used for video console as shown in Figure
10-2.

Zoomin
Selact Percentage for Scallng Screen
Zoom Out
Sered CirHrAlt-+Del 10 Remote
Auto Adjust Screen
| =) 192188.10249 |
’ 0 - Cirl+Al+Del [_[ Opticns
O'pen or Close Qukck Shot Panel Options
Quick Shot
Screen Capture
Full Screen
Stop Video Redirection
Start Video Redirection

Figure 10-2 Video Console Toolbar

3 Start Video Redirection:
This button is used to start video redirection. IPMI View will automatically start the

video redirection when you click the Video console tab.
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. Stop Video Redirection:
This button is used to stop video redirection. To stop video redirection, press this
button again to stop it. Please note that the drive redirection will continue to work

when it is enabled.

r% Full Screen:

This button is used to maximize the size of the remote video screen on the local
computer display. You may press <alt + enter> to return to the original mode. Please

refer to Figure 10-3.
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Screen Capture:
This button is used to capture the screenshots of the remote managed systems. You

will see a file-save dialog box with a preview image. Select the directory and filename

to save it. The file format can be PNG or JPG.

@ Quick Shot:
This button is used to capture quick screenshots. You will need to first specify a
directory where you want to store quick shot images. You will see the quick shot

images in the quick shot panel. Please refer to Figure 10-4.
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Figure 10-4

3/ Open or Close a Quick Shot Panel:
This button is a switch used for opening or closing the quick shot panel. Double click

the image in this panel to show a full-size window for viewing.

@‘ Zoom In:

This button is used for zooming in the screen (up to 300%). Please refer to Figure
10-
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®*~ Zoom Out:

This button is used for zooming out. The maximum zoom out percentage is 10%.

Please refer to Figure 10-6.
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Figure 10-6

[100% =] select percentage for Scaling Screen:
This combo box allows you to select the setting of screen scaling, either 10%, 25%,
50%, 75%, 100%, 200%, 250% or 300%. An additional selection allows you to scale

to fit with the IPMI View window size.

Ctrl+at+0el Send Ctrl + Alt + Del to Remote:

This button is used to send the <Ctrl + Alt + Del key >combination to the remote

system. It is useful when the remote system is running in the BIOS, DOS or Windows

environment.
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@ Auto Adjust Screen:
This button is used to adjust the screen automatically. Press this button if it's difficult

for you to see the whole screen.

QOptionz .
¢ Options:

You can select more options here. The list of options is listed below.

* Monitor Only: Use this feature to display the remote screen only. The keyboard
and mouse will be disabled.

* Readability Filter: This item uses algorithm to improve screen display. This will
allow you to see the text content easier when you scale the screen.

* Local Cursor: Use this to change local cursor settings.

* Chat Window: This feature allows the user to chat with each other via the IPMI

connection. Please refer to Figure 10-7.

17 192.168.10.24 Chat
§in@IEM-IICA4107030(super J=> test

root@linuxsuper j== 456

jim@IBM-DDCE4107D3D(super) | I Beep

Figure 10-7 Chat Window

* Video Settings: This feature allows you to configure the advanced video settings.

Please refer to Figure 10-8.

17 ¥ideo Settings X

Brightness _« | | | 70
ContrastRed < | Il _+ 114
Contrast Green  _« | | _+ 110
ContrastBlue  « | | | 112
Clock ] 1 _+ 1344
Phase 1 | 29
Horizontal Offiset _« | | | 308
Vertical Offiset  «[ | | 34
‘Resetthis Mode}| Reset All Modes |
Save Changes | 1,024%768 60Hz Undo Changes

Figure 10-8 Video Settings

* Refresh Video: This feature allows you to refresh the video screen.

38



Supermicro IPMI View User’s Guide

* Soft Keyboard: A virtual keyboard is provided for easy input. It also provides

localized keyboard mapping. Please refer to Figure 10-9.

English (Inited States) 104pc

Esq  F1|FZ2|F3|F4|F5|FG|FT|F8|FIF10F11F1Z Prn & | Brk
lafzlalals]s7]a[alo]-[=][=[n[~[2]&]i]*]-
IfquertyuiDp[](JDellEndI|'\1‘I+
Slals|(d|{flglh|j ki 1];]"|\ 4+ 5|
|z x| v|bn|m|l,| . || ©F t| Edd|T
cirl | St{Al Alt | Sthel ot [« [+ |=[ ins De*

Figure 10-9 Soft Keyboard

* Local Keyboard: This feature allows you to set local keyboard mapping settings.
* Encoding: This feature supports encoding for the video screen. The options for

encoding are “Predefined”, “Compression” and “Color Depth”.

Status Bar
Figure 10-10 displays the status bar for the video redirection.

l\rhm memﬂmlmbytes per secorxd
Start Video redirection Fp=: 20 In: 184 KB/= Out: 204 B/s ii %

snarahioca | Monor Mods

Figure 10-10

Start Wideo redirection
Messag e:

This section displays tool tip information and the video redirection status.

Fps: 20 In; 184 KB/= Qut: 204 Bi=

This section indicates the number of the frames displayed per second, and Input
(Kbytes per second)/ Output (bytes per second).

a a
44 share Mode:

This icon indicates the status of screen-sharing on the remote system. If there is only

a
one user using the video redirection of a remote system, the icon will look like & | If

two or more users using the video redirection of the same remote system, the icon

™ ]
will look like @4/
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-
= Monitor Mode:

O
This icon displays the status of monitor mode. When the display looks like it

indicates that you can use the local keyboard and the mouse to control the remote

screen. When the display looks like % , itindicates that the local keyboard and the
mouse are not available. If you select the option “monitor only”, the keyboard and

mouse will be disabled.
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11. Virtual Media

The Supermicro Intelligent Management (SIM) Module provides a Virtual Media
feature, which includes a Virtual USB Floppy, a CD-ROM image and Drive
Redirection.

Figure 11-1 shows the Virtual Media GUI. The Virtual Media Status section displays
the current virtual device status. There are two virtual drives available.

Floppy Image Upload allows the user to upload a floppy image as "floppy" located at
the remote host. The floppy image uploaded shall be in the binary format with a
maximum size of 1.44MB. It will be loaded to the Supermicro SIM card and emulated

to the host as a USB device.

The CD-ROM Image on the “Windows Share” allows the user to configure Windows-
Share settings. It allows you to decide how you want to share the data stored in your

shared folder with the users on the remote host system.
Drive Redirection makes local drives accessible to other users via console redirection.

This function allows you to share your local drives (floppy, CD-ROM and HDDs) with
users on remote systems.
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102.168.10.241

Virtnal bedia Statoz
Dirive 1 Diive 2
Type : Floppy image Empty

Read / Write mode: Wiitable
File name : floppy.dmg (1474500 bates)

Floppy Image Upload CD-EOM Image on Windows Share
Diriwe: (2w = Open ] [ Tpload Dirive: m w m
Floppy Image file: Share host:
CMloppy img Share name:
Path to image:
Upload floppy image done Tser (optional):

Pazzwond {optional):

Dirive Fedirection

Diive 1 Mot connected

Drive Redirection disconnected

Diwive 2| Connect Drive ” Connect I3 |Hot connected

Divive Redirection dimonnected

(@smomi] ®

Login | Event Log | Sensorez | IFM Device | BMC Setting | Users | Text Console | KV Conmle | Virpal Media

Figure 11-1

Floppy Image Upload

As shown in Figure 11-2, click <Open File> to select the file that you wish to upload to a
specific host drive of your choice. Click <Upload> to upload the floppy image. Please
wait for the uploading process to complete. The virtual floppy will be activated after the

floppy image is uploaded.
Floppy Image Upload

Dirivver
Flopgy Image file:

C:floppy img

Unloading floppy image

[ )

Figure 11-2
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CD-ROM Image on Windows Share

Please refer to Figure 11-3 for the following items.

Drive: Specify the drive that you want the remote host to share.

Share Host: Enter the IP Address or the name of the system you wish to share
data with via “Windows Share”.

Share Name: Enter the name of the shared data in the remote host.

Path to Image: Enter the location of the source file that you wish to share via
“Windows Share”.

User/Password (Optional): Enter the user and password for the person to
access the data that you want to share, and click the <Set> button to enter your

selections as shown in Figure 11-3.
CD-ROM Image on Windows Share

Drive: (2w

Share host: 19216810117
Share natme: =0
Path to image: CO IS0

U=ser (optianal):

Pazsword (optional):

Figure 11-3

Drive Redirection

As shown in Figure 11-4, Drive Redirection supports both local drive and the ISO file.

When you click the <Connect Drive>, a dialog will show up as figure 11-5.

Local Drive List: This box displays a list of local drives available for remote
access. Select from the list a local drive that you want to make accessible for a
remote server.

Refresh List: Click this button to refresh the local drive list.

Write Support: Check this button to allow the remote operating system to have
write access to the drive that you have selected. This function allows a user to
alter, overwrite, erase and destroy data stored in the drive selected. This feature
should only be used with non-critical data. Select the drive and click “OK” to start

direct redirection.
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The second type of drive redirection is “Connect ISO”. You may redirect the
ISO file directly from your file system. Click this button and select an ISO file

to start this function.

Drive Redirection

Drivel:[ Connect Drive H Connect [30 ]Notconnecied

Cancelled Dirive redirection

DriveZ:[ Connect Diive ][ Connect [30 ]Notconnechad

Drive Redirection distonnected

Figure 11-4
:: Select a drive to redirect @

= (Hard Disk) v [ Refresh List ]

[] Enable Write support

| ok || Cancel |

Figure 11-5

Stop Active Drives
As shown in Figure 11-6, click <Stop Drive 1> to disable Drive 1 and Click “Stop Drive
2" to disable Drive 2. The <Refresh> button is used for refreshing the Virtual Media

settings. If you want to stop or change the type of a virtual drive, you first need to stop it.

[ @stopDrivel |[ @ StopDrive2 | [ Refresh

Figure 11-6
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12. Group Management

Group management is a way to manage multiple servers at the same time. For
example, you can query the fan sensor readings from multiple servers and note their
differences. Also, you can simultaneously power on or off multiple servers at the
same time. As shown in Figure 12-1, click <Manage Group> to show group
management. In group management, you can select multiple servers from the host
group on the left and manage them with the functions provided. You may re-arrange

groups of servers in the group list to make server group management easier.

07 IPMI View ¥2.6.29 (build 070927) - Super Micro Computer, Inc. =
File Eit Session Help

BE a3l R e

j Group Management

SUPERMICR® T

IPMIDomain =~ & + & £ & = m E

Woltage | Sensors| Event Log | ACPI | Power | LAN Config | FRIT | Text Consnle | General Info

Fan

Systern. Narne i Sensor Nare Reading Unit Low Limit

25 Groups C&d?
MM 17141 Domsin (4/4)

] Refuech every ssconds

Get Virtual Media infomation done

Figure 12-1

In the group management, a Login ID and password are required. Click <Manage >
Setting to set the login information. Please note that IPMI View will use this account
to login to multiple servers. (Figure 12-2)

Group Login Setling El

i) LogmID ADIMIN|
M

sawe [0 and Password
* i dmindstrator level iz required

Figure 12-2
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IPMI View provides various tools for group management. As shown in Figure 12-3,
group management can be grouped to the following categories.
* Fans
. Temperature
* Voltages
. Sensors
. Event Log
. ACPI
. Power
. LAN Configuration
* FRU
e Text Console
*  General Information
Group Management
Fan | Temperature | Wottage | Sensars | Evert Log | ACPI | Powwer | LAR Config | FRU | Text Conzole | General Infa

Figure 12-3

Fans

After you've selected multiple servers and clicked the <Fan> tab, a window will
display as shown in Figure 12-4. You can use <Ctrl+Click>, <Shift+Click> or draggin
your mouse to select servers. Click the <Query> button for IPMI View to collect the
fan readings from the selected servers. The information listed in the table shows the
fan status of the selected servers. If a fan reading is colored in red, the fan may be
broken, not installed, or the reading is below the lower limit. When this occurs, the
Administrator should take precautionary measures to ensure that the system

functions properly.
You may refresh the fan status by checking the Re-flash checkbox. IPMI View will

refresh the fan status based on a preset schedule. Please note that IPMI View will

not refresh if you switch to another tab.
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07 IPMI ¥iew ¥2.6.20 (build 070927) - Super Micro Computer, Tnc.
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Figure 12-4

Temperatures

The screen shown in Figure 12-5 indicates that multiple servers have been selected,
and the Temperature tab is pressed. Clicking the <Query> button allows IPMI View to
collect the temperature readings from the selected servers. The information listed in

the table shows the temperature settings of the selected servers.

7 IPMI View ¥2.6.29 (build 070927) - Super Micro Computer, Inc.

Fls Fdit Ssssion Mnags Help
00 2
s Group Management
Fan| Tempersture | Voltage | Sensors | Event Log | ACEL | Bower | LAN Config | FRU | Text Console | Gensral Info
Tewperate
41 System Name P Sensor Name FReading nit High Limit
(=} 152 165 1031 10216310241 19216310241 (P Temp 1 50 egree 50
71 192.168.10.243 il eeree
- OO TEAI024]  121ARI0241 PO Temm 2 = Asgres © 750
10218810341 10216810241 (CFU Temp 3 0 Hegree © 750
01610241 1921ARI024T P Temp d 1 Asgres © 750
21810241 (19216010241 v Teunp 30 Aegee C 750
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[ Retresh every seoonds st updated 200710001 15:50:25 (5)
Finich

Figure 12-5
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Voltages

After selecting multiple servers and < Voltages> settings, you will see the display as
shown in Figure 12-6. Clicking the <Query> tab will allow IPMI View to collect the
voltage readings from the selected servers. The information listed in the table shows

the voltage status of the selected servers.

7 IPMI View ¥26.20 (huild STU9IT) - Supes Micro Computer, fuc
Fle Eld lecn Memg Hib

o e 809 R e
SUPERMICR@ T Sroum Heneaement

Fua | Temgperatuss| Voluge | Zeaors | EventLog | ACF | Powss | LAN Contig | FRIF | Tooat Conele | (enersdlate,

1602 160 10 343

] Domain %)

Eﬁm [T ¥ X

[ Bstmhemry |60 w mooads ot wpdaied 00710401 153237 06)

Figure 12-6

Sensors

After selecting multiple servers and clicking the <Sensors> tab, you will see the
window as shown in Figure 12-7. Click the <Query> button for IPMI View to collect
the sensor readings from the selected servers. The information listed in the table
shows the sensor status of the selected servers. The window here shows the chassis
status and power supply status. If the chassis is opened or a power supply has failed,

the reading will be in red.

7 EPME Fiew ¥26.29 (build (T092T) - Super Micen Compater, fac
Fie Ed2 Desca Mumg Bep

0O agoe Re

SUPERMICR@ 7 Sroue Managemant

| Tompeeatems | Vatugs | 54900 | Eveat Log | ACH | Powss| LAN Coatig | FRU | Trod Conmole | Genend 1ako.

o (YTL}

IFMI Doman G4F)

[ Btmshroney 6 e smemds ot iehaned 200THNA 15:55:32 64}

Figure 12-7
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Event log

After selecting multiple servers and clicking the <Event Log> tab, you will see a
display as shown in Figure 12-8. Click the <Query> button for IPMI View to collect
the event logs from the selected servers. The table below displays the event log of
the selected servers. Select the <Host combo> box to filter the event log data in the
table.
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Figure 12-8

ACPI

After selecting multiple servers and clicking the <ACPI> tab, you will see a display as
shown in Figure 12-9. Click the “Query” button for IPMI View to collect the ACPI state
from the selected servers. The table displays the ACPI state of the selected servers.
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Figure 12-9
Power

After selecting multiple servers and clicking the <Power> tab, you will see a display
as shown in Figure 12-10. Click one of the power <Control> buttons to send a
command to the selected server. The text area will show the result.
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Figure 12-10

LAN Configuration

After selecting a single server and clicking the <LAN Config> tab, you will see a
display as shown in Figure 12-11. Click <Query> to get the information needed from
a single server and copy it to other servers for data-sharing. The text area will show
the results of the query and provide updates. The <Clear> button is used to clear the

text field only; it will not clear the actual LAN configuration from the server.
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Figure 12-11
FRU

After selecting a single server and clicking the <FRU> tab, you will see a display as
shown in Figure 12-12. Click the <Query> button for IPMI View to get the FRU
information from a single server, and copy it to other servers for data-sharing. The
text area will show the results of a query and provide updates. The <clear> button is
used to clear the text field only; it will not clear the actual FRU data from the server.
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= Groups Rade
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Figure 12-12

Text Console

After selecting a single server and clicking the <Text Console> tab, you will
see a display as shown in Figure 12-13. Click the <Open> button for IPMI
View to create an internal text console window for the selected server. Click
<Start> to start the text console redirection. The power control buttons
displayed on the status bar provides power on, power off and reset commands,
allowing you to easily power on or power off a remote server. The <Encode>
checkbox is for RMCP+ encoding. Check it to enable packet encoding

between the IPMI View and a server.
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Figure 12-13

General Information

After selecting multiple servers and clicking the <General Info> tab, you will see a

display as shown in Figure 12-14. Select the fields you want to query from the

servers, and click the <Query> button to allow IPMI View to collect the information

from the selected servers.
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13. Trap Receiver

The Trap Receiver is a utility used for receiving traps from the BMC. In the event of a
sensor error or a sensor reading that exceeds a threshold, the BMC will send SNMP
traps to the destinations set in the BMC. The Trap Receiver is executed on the
destination site and receives the SNMP trap from multiple senders (BMCs). If you
select a category, you can see all the traps in that category. Furthermore, when you
click a trap in the trap list, you can see its details in the <Trap Structure> window.

Please refer to the BMC Setting page in IPMI View to set the SNMP destination.

As shown in Figure 12-1, there are several components to the IPMI Trap Receiver.

* Menu Bar: contains pull-down menus for exiting the programs, getting help, etc.

* Tool Bar: contains all IPMI Trap Receiver features.

» Category: categorizes the traps by the sender, community and sensor.

e Trap Structure: It is a tree structure that displays traps in detail.

e Status Bar: shows messages regarding the current status of related
components.

* Trap List: shows detailed information for traps received.
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= ] ShiF Header Ty [ e HI s e 7l - agoarg bagh ARBAIAN 15 4K K
# Wessags Lengin 125 13 [9216510245 pubic CRU Unpert Monrecoverable - going high [2005/1 0001 15:465:26 . _Tmp List
# Mzssugs Yorson, vl 14 182AC0AD2MS  pukl rAN D Lowrar on ertiesl  gaing by S005H UM 154835 .
# Uommunity: puthc 15 [19216510245  pubic FAM 3 Lower CrRical - ooirg e 20050001 154526 .
= | H1¥ 1 HAsAr i3 19216510243 puliic FAM 3 et MONTETOVErEYE - Quing low 003N 001 134528 ..
® Iype Irap 17 A7 1RRIN 745 pabie FAN S rrwier nn-nrtical - gring kv AT 154579
Trap ,m'ucture_ }— * lengh 103 1A |17 IRA INP45  gudi: Fah 4 e (ol - i boew PINSATNT 15 45 31
® Eerpries 1361403180 | 19 [[G216500245  pubii FAN Lurmrer Murireunesreios - guinyg heer | 200570001 15,4832
® Lgent B 1¥LIES 1048 M [EPIRRIN P45 okl CRI Iper Hon-nrical - oning high AN 154549
# Cenzric Trap Type: € CU TR TR T DR T (#11 Inper Cxiheal - gong hoh ARBAINN 154451
® penhe Irap Iype TRANE | |22 19216610245 pubic U get HonTecoverable - going high | 20051001 154350 .
& Dmebuis | 11BEIERL 1 MEPACAAN PG ke ranN 7 L L e FNEHNM 45507
= ] F0U Booy Tz 19208800245 bk FAN 2 Lurmrer Criiced - wuiny e 20051001 15.50.06 .
% Tnta | angfh nt Yarksivn R 25 19206610247 ki FAMZ ewrwer Murrsaereriide - guing ke 20050001 15,5010 . |2
= | end (97 1RRIN 745 ke FANS rrwier hnnrtical - gning bve AT 155077
# Lemtn CTEINGNg 70 ™| [77 197 1RA IN745 - FANS vrwes Crind - miirag bow AN 155075 |
< > [Sener =197 1R 1N 245 , Crmmnly = * | Senane = *
Slatus Bar e irn recaren s 102188 11097 _conant — | £HI ] ipper Mon racnveaiie. gong ioh

Figure 12-1
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Tool Bar functions

The tool bar provides the following features as shown in Figure 12-2.

> @ B a o =

Stop Save Load Clear Email

Figure 12-2

e Start: starts the Trap Receiver.

e Stop: stops the Trap Receiver.

* Save: saves the traps received into a file.

* Load: loads a saved trap file into the Trap Receiver.

e Clear: clears all the traps in the trap list.

* Email: displays an “Email-Alert Settings” dialog box (see Figure 12-3). Fill the
“SMTP server”, “From (email address)” and “To (email address)” fields. The
“From” and “To” addresses must be valid in the SMTP server. If the SMTP
server requires authentication, please enter the username and password.
Once entering needed information, click the <Test> button to verify if your
email works properly.

Email Alert 3

Email Alert Setting

[] Enakile Email Alert

SMTP Server:
Fram:
Ta:

[ Authertication

Lisername:

Pazzword:

Figure 12-3

Category

There are three categories including: Sender, Community and Sensor as shown in
Figure 12-4. The Sender page lists all sender IP addresses. The Community page
lists all SNMP communities. The Sensor page lists all sensor types from the traps.
Clicking on each category type will act as a filter for all traps in the traps list. Click the

<All> button to cancel all filters.
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Category All

2l
& 19216810245
& 19216810247

Category All

2]

& public

Sender | Communty | Sensar

Category All

Sender | Community | SEnsor

FamM 4
FAM 3
FamM 2
CPUA
FAmM 1
FAM S
FAME
FamM T
FAM S
Irtruzion

-
.

LR O O K

Sender || Community | Sensor

Figure 12-4

Once a category has been selected, the filter condition will be displayed at the

bottom of the “trap” list. See Figure 12-5 for reference. As displayed in Figure 12-5,
the filter is “Sender = 192.168.10.245, Community = public, Sensor = CPU 1”. The
trap list displays only those traps whose contents are included in each of the three

filters.
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Trap Structure

The Trap Structure displays detailed information for the selected item in the trap list.

[urm Sender Corrmunity Sensar Description LocalTimeStarmg

10 192165810245  |public CPUA Lpper Mon-critical - going high {20054 0001 15:46:22...
11 19216510245 |public CPU A Upper Mon-critical - going high (2005410001 15:46:25...
12 19216810245  |public CPU Upper Critical - going high 200540401 15:46:26...
13 192165810245  |public CPU Upper Mon-recoverable - goi... (2005010001 15:46:26...
20 192165810245  |public CPUA Lpper Mon-critical - going high {20054 0001 15:45:49...
2 19216810245  |public CPU Upper Critical - going high 200540401 15:49:50...
22 19216810245 |public CPU Upper Mon-recoverable - goi... (200540001 15:43:50...

Sender =192.168.10.245 | Community = public | Sensor = CPU 1

Figure 12-5

Information includes the “SNMP Header”, “PDU Header”, “PDU Body”, “Bind” and “PET”

data.

Trap Structure

|| ShMP Trap
=l [ | SNMP Heacder

# Message Length: 125

# Meszage Yersion: vl

& Community: public

=l || PDU Header
Type: Trap
length: 109
Erterprize: 1 36141 318311
Agert P 192165810245
Generic Trap Type: 6
Specific Trap Type: 262400
Tirmeticks @ 1128180281
=l || PDU Body
# Total Length of Yariable Binding: 72
=l || Bind
# Length of Binding: 70
# 2136141318310
= || PET Data
& [FAN 3] Lower Mon-critical - going low
& " [H0=E]" @2 TF] @ [x8x00x 020

LR R BN B S

Figure 12-6
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Receiving a Trap

When the Trap Receiver receives a trap from the BMC, an alert bar will display on

the screen for about 10 seconds to notify you that a trap has occurred. In addition, an

email alert will be sent according to the information field in the Email Alert dialog box.

Please refer to Figure 12-7.

The email will include the following information.
A SNMP trap received
Sender:192.168.10.247
Sensor:FAN 2
Description:Lower Non-recoverable - going low
Time:2005/11/22 14:27:07 Tue

¥ IFMI Trap Receiver ¥2.0 {(build 051122) - Super Micro Computer, Inc.

File Help
Stop Save Lo Cleat Etrizil
Category all L Sendr Comunity Sensor Description LocaITmStamp

19216810, [public Lowver Critical - going lovy 2005 0001 15:24:3 ..
# 19216510245 192 165.10... |public F AR 4 Lowver Mon-recoverable - goi... (200500001 15:24:4 ..
# 19216510247 192165.10.... |[public Far 3 Lovver Mon-critical - gaing lowve  [20050 0001 15:24:4 .
ACDACRAR - ndetin Canta e Codtis=bmsing lovy 200540001 15:24:4...
ATrap Received rable - goi... (20050 0001 15:24:4
Sender 192 162810.247 - going lowy  [20030 0001 13:46:1 .
Sencey | Cormmurity || Sensor Content: [ FAN 2] Lower Critical - going low n o - 2005A 001 1524801 .
rable - goi... (20050001 15:46:1 ...
Trap Structure T T9Z. 100, 10, [T CELT e THOF-CTInCET - going high (20050 0001 15:46:2 ...
L1 SMMP Trap A1 192.165.10.... [public CPL A Upper Mon-critical - going high (2005010001 15:46:2...
=[] SNMP Header D E 192.1658.10.... [public CPU Uptoer Critical - goitg high 200540001 15:46:2...
# Messzage Length: 125 13 192.1658.10.... [public P Upper Mon-recoverahle - goin... (200500001 15:46:2.
# hessage Yersion: vl 14 192.165.10.... [public Far 3 Lovver Mon-critical - gaing lowe  [20050 001 13:49:2 ..
& Comtnunity: public 14 192.165.10.... [public Far 3 Lowver Critical - going o 200501 0001 15:45:2 .
= _| PO Header 16 19216810, [public Far 3 Lovver Mon-recoverable - goi... [20054 001 15:49:2.
® Type: Trap 17 152.168.10.... |public FAN 4 Lawver Mon-critical - going low 20050 0001 15:49:2...
& length: 109 18 192165.10.... |[public Far 4 Lovver Critical - going 10w 20050 0001 15:49:3...
# Enterprize: 1.36141.3 149 192.1658.10.... [public Far 4 Lowwer Non-recoverable - goi... (2005010001 15:49:3..,
& Agent P 192.165.10.242 20 192.1658.10.... [public P Upper Mon-critical - going high  [20054 001 15:49:4
& Generic Trap Type: 6 21 192.165.10.... [public CPL Upper Critical - going high 20030 0001 15:49:5...
# Specific Trap Type: 262¢ 22 192.165.10.... [public CPL A Upper Mon-recoverable - goin... (20050 0001 15:45:5
# Timeticks : 1125150277 23 192.1658.10.... [public Far 2 Lowver Mon-critical - going love  |[200504 001 15:50:0...
= _| FDU Bocy 24 192 165.10.... [public Far 2 Lowver Critical - going lovw 2005 0id1 15:50:0...
# Total Length of Variakle K. 25 192165.10.... |[public FAR 2 Lovver Mon-recoverable - goi... [20050 001 13:30:1 ...
£ '_‘I L > a Sender =* | Community = * | Sengar = *

A Trap Received: Sender P =192 168.10.247, cortert = [ FAN 2 JLovwer Critical - going love

Sending Email ...

Figure 12-7
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Appendix A: SIM Firmware Update

1. Select a remote system on the System list and click “File > Update IPMI Firmware”

to start the firmware update.

Edit Session Manage
Wew... *
Dizeover IPMI Device

Reload Confignration
Save Configuration
Tpdate [PMI Firmware

Language *
Exit

Figure A-1

2. Click the <Open> button to select the<firmware> you desire and then click <Start>

;j Tpdate Firmware @

IP: 192.168.10.249

Firrmeare File: | | Open Start

Message:

to continue.

Figure A-2

3. A login dialog will appear. Please enter the Login_ID and the password. This user

will be granted the privilege as an Administrator.
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Flease imput ID and Paszword r$_<|

Login IC ADnAIN

Password ok

* Administrator level is required

| oK || Concel |

Figure A-3

4. A firmware information dialog will appear. It shows detailed information on the
current and new firmware. Click <Yes> to continue.

Request Confirmation E‘

Crrresnt fivmsware:
Firmeware Version: 1.5.0 build 4238

Firmware Tag: Aug-14-05-17-30
hardware 1D 032
OEM: peppercon

Hew firmyware:

Firmware Yersion: 1.5.2 build 4238

Firmweare Tag: Aug-16-08-11-10

Firmnware Size: 3992376 bites

Firmware Path: C\fw-kira-kimamigd-smide-peppercon_040200-4238-081606-1-5-2 bin

Wonld vou like to continue ?

Figure A-4

5. The firmware file will start to upload. This process may take few minutes to
complete.

IP: 192.168.10.24%

zrcon_040200-4235-081606-1-5-2 hin |

Firmwvare File:

Uploading firmweare

[

Meszage:

Login to 192.168.10.249
tart firmware upgarde

Mploading firmware ...

Figure A-5
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6. Please wait for the firmware to upload. Once uploading is completed, the BMC will
start to flash the firmware internally. This step may take about a minute. Please try to

connect to the system after two minutes.
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Appendix B: SIM(W) KVM Console

and Virtual Media

SIM(W) KVM Console allows the user to perform console redirection via KVM

(Keyboard/Video/Mouse) support as shown in Figure B-1.

1j IPMI View ¥2.7.12 (build 100504) - Super Micro Computer, Inc.
File Edit Session Manage Help

Bl abde® s e

S o 192.168.12.169
UPERMICR® @ @ O munsereen [X Vsl edia [ Soft Keyboard dfps [ Meno
IPMIDomain & ¥ & # &

-~

13 12 i Fanl 675.00 RPM
192.188.12.171
172.31.2.184 14 13 i FanZ 0.00 RPM
15 14 i Fan3 0.00 RPM
16 1?7 | PS Status 0K [0 CO 00 001

C:n>ipmicfg —sdr >aa

o] 172.31.2.145 )
172312146 C:n>type aa

SDR 1D i Sewnsor Sensor Reading
17231162
%1?2_31_2_31 3 CPUZ Temp nsa [0 EQ 07 001
] 172.31.2.58 System Temp 36.00 degree C

CPU1 Ucore .12
CPUZ Ucore .00
+12U .31
+3.3V .23
DIMH .81
+5U .06

T 172.31.2.59
o 172.31.2.62
Tl 172.31.2.181
= 19216810118
) 192.168.10.90
& 192.168.10.30

& 192.168.10.50 UBAT Z3

Fanl .00 RPM
Fan2 .90 RPM
Fan3 0.00 RPH
PS5 Status i OK [00 CO 0O 681

E&d&e

#
2
3
4
5
b
ks
[i]
9
10 +3.3USHE .23
11
1z
13
14
17

5 New Groupd (322)

Redirection Viewerstarted....

Login | Event Log | Sensors | [PM Device | BMC Setting | Users | Text Console | BV Console

RMCP+ Open Seszion successful

Figure B-1 SIM(W) KVM Console Main Screen
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SIM(W) Console Toolbar

The SIM(W) Console Toolbar provides seven tool buttons which will allow the user to

perform the following actions as shown in Figure B-2.

Siant Video Redinection
Siop Video Rediredllon
Screenshnt
Refresh {the page}
Full Screen (disptay)
!
L@ QIFU.“ Screen (_EI Firtual Media Suftf(r}rbnard 1 fps EMEJIU.
| Bofl Keyboand i use the solt keyboard} L"
Virlual Miadia (o use Virtus Madia}

Figure B-2 SIM(W) KVM Console Toolbar

|} Start Video Redirection:
Click this button to start SIM(W) KVM console redirection.

O Stop Video Redirection:
Click this button to stop video redirection. Please note that the drive redirection will

continue to work when it is enabled.

QI Full Screen:

Click this button to maximize the size of the remote video screen displayed on the

local computer screen as shown in Figure B-3.

Figure B-3 Full Screen
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| |
Virtual Media:

Click this button to enable Virtual Media support as shown in Figure B-4.

“4 Virtual Media X]

Brows ’ Comnect Floppy l

FloppwISE Kev Media

CD Medi
@ 15O Image | Bowe | [ ComctCDDYD
OF
OF

Statos

Target Dirdve Comnected To Fead Bates

Virtnal Floppy ot connected nfa
Virtnal CD ot comnected its

Cloge

Figure B-4 Virtual Media

* Floppy/USB key Media: This feature allows the user to redirect Floppy/USB
Media.

e CD Media: This feature allows the user to redirect CD/DVD or ISO image file.

* Connect Floppy: Click this button to start to redirect your Floppy Image or USB
Key Media.

e Connect CD/DVD: Click this button to start to redirect your CD/DVD or ISO
image file.

LY Soft Keyboard:
Click this button to use the Soft Keyboard for console redirection as shown in Figure
B-5.
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sSoit Eeyvboard v0 96
Langmage

| English(United States) v
() Single Key

gd F [Fz (s (R | B[R (2 [me | P [maolRuilmig]  psedlpe

i (2 3 (4 (5 Gl 7 | S (1 l— = B3 Inz (HooPUy  Nuw! [* |-
Tab g [w (e. Tt o (u 1ol ral [l ]l Del |End|PDin Hon t+ |FiUp
Cap la s 'd T =gl 'i kgl ; + = = |+
Shift 2 (:-: CH o b (n gl ! shift i End| § |FDm
Cd | winlat | ab[wilapdcm | < lp |=| s |Dal]w

Figure B-5 Soft Keyboard

* Language: This feature allows you to select a proper language setting for your
soft keyboard.

e Combination: Check this button if you want to use a combinations of modifier
keys

* Single Key: Check this button if you want to use a modifier key as single key.

* Lock: Check this button to hold the modifier key you've clicked.

The menu is same as web KVM UI.
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Appendix C: SIM(WA) iIKVM

Console and Virtual Media

Press <Launch KVM Console> to open SIM(WA) iKVM Window as in Figure C-1.

__j IPMI ¥iew ¥2.7.13 (build 100504) - Super Micro Computer, Inc.
File Edit Sesson Manage Help

1l @ @ ©

Fﬂ 17231262
il 172.31 2181
g 102.168.10.118
& 1921681030
19216810 50
g 17231217
& 172312161
& 17231173
& 1
EJJ 102.168.12 52
172512114
172.31.1.132-1
102.168.10.174
202128183134
102.168.10.165
17231149
17251136

172311132

l4mn a9 oAy

18

(2 Mz (e e

IPMI Domain & + @ £ 4
-~

v

IPMI Diomain
] New Grooupl (27100

) Wew Grooup (322)

=8l Groups Ed&de

{[ = 192 168 12,160 | ® 192.168.12.125

Console Redirection

_i, Press the button to lavnch the redivection console and manage the seover remotely.

Launch EVM Console

| Login || Event Log || Sensors || IPM Device || BMC Setting || Tsers || Text Conzole || KV Console |

JEMCP+ Open Session successful

Figure C-1 SIM(WA) iKVM Window
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Please note that SIM(WA) iKVM window supports same features as other versions of
Web KVM as shown in Figure C-2.

Java iKYM Yiewer v1.55 7 [192.168.12.125] - Resolution 652 X 492 - FES 0
Virtal Med;i' Record  Plawback  Macro  Options  UserList  Exit

Press any key to enter the menu

Booting Cent0S (£.6.18-164.e15) in 3 seconds.. I

Figure C-2 iKVM Window

Virtual Media (USB Floppy & Flash)

Click <Virtual Media> on the menu bar and then click <Virtual Storage> to display the
Virtual Media (USB Floppy & Flash screen) as shown in Figure C-3.

Virtual Media 1.2 12

CDROM&EIRD
Setting for Device 1
Logical Drive Type Image Filename and Full Path
|N0 Select ~ | | |
(e ] [ men

Connection Status History

¢ bt

Figure C-3 Virtual Media (USB Floppy & Flash)
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Logical Drive Type: From the pull-down menu select the logical drive type.
Image Filename and Full Path: Enter the image file name and the full path to
the file. It is available only for ISO files.

Refresh: Click this button to refresh the page.

Plug In: Click this button to mount your logical drive as virtual media.

Plug Out: Click this button to un-mount virtual media.

OK: Click this button to confirm and exit.

Connection Status History: This window displays the connection and the status

of virtual media.

Virtual Media (CDROM & ISO)
Click < CDROM & ISO > to display the Virtual Media (CDROM & ISO). as shown in
Figure C-4.

B Virtual Media 1.2 12

Setting for Device 2
Logical Drive Type Image Filename and Full Path
o Select ~
T T

Connection Status History

Figure C-4 Virtual Media (CDROM & ISO)

Logical Drive Type: From the pull-down menu select the logical drive type.
Image Filename and Full Path: Enter the image file name and the full path to
the ISO file.

Refresh: Click this button to refresh the page.

Plug In: Click this button to mount your logical drive as virtual media.

Plug Out: Click this button to un-mount virtual media.

OK: Click this button to confirm and exit.

Connection Status History: This window displays the connection and the status
of Virtual Media.
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iKVM Virtual Keyboard

Virtual Keyboard provides soft keyboard support and allows the user to click a key on

the soft keyboard by using the mouse when a keyboard is not available. Refer to
Figure C-5 for Virtual Keyboard.

Englizh keyhoard Z”:, r>__<|

e F1|F2|F3|F4| |F5|F6|F7|F8| [FQ|F10jF1|F12 psc glk | pau

123 (4|56 |78 |90 |- = = [fms|™ |t |kl /|*]|-
Mg |w rf|t)|y|ufifo|p|[]] | \ljdel{ | F ||| T2 N
JlLla|s|d|f|g|h|j|k s - = |—=
T |z |=x|c|v|b|n|m|,]|. |/ 1 T | ] F
ctrl || alt FDEEI ENE T

Figure C-5 Virtual Keyboard
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Appendix D: SIM(W) Firmware
Update

1. To re-flash SIM(W) Firmware, please select an SIM(W) device and <Update

firmware> in the menu. A dialog box appears.

Confirmation

- | ) Thiz 1z SIM M) device. Fleass make sure wou have corect firmware for vpdate (* ima)

| 0K [ Cancel |

Figure D-1 SIM(W) Firmware Re-flash

2. Make sure that you've selected the correct firmware for update, and click

<OK>.This dialog box appears.

Y AFTFlash rg|
Remote Flash Tool for Hermon/AM FW V121
IP: |192.168.12.169 | Options
[] Preserve Bootloader
File: | | [ Browss... ]
[] Preserve Config Madule

Figure D-2 YAFU Flash

3. After you've selected a firmware file for remote flashing, it will be checked if it is a

valid file before remote flashing starts.
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Y AFTTFlazh &'
Remaote Flash Tool for Hermon/AM FWW V121
IF: |192.168.12.169 | Optinns
. - [ Presive Bootloader
File: |[DAFWWAMIEIDCT-L 1304ma | [ Browse |
[] Preserve Config Module

Hew firmware verson : 1 30

Figure D-3 YAFU Flash

* |IP: This item displays the IP Address of the IPMI device.

* Browse: Enter the file name or browse the data base to select a file that you
want to perform remote flashing.

* Preserve BootLoader: Check this box to preserve the settings of BootLoader.

* Preserve Config Module: Check this box to preserve the settings of
Configuration Module.

* Firmware Version: The new firmware version will be displayed.

* Flash: Click <Flash> to commit the file for remote flashing.

4. Click <FW Version>. Remote Flashing can only be performed by an Administrator.
If you are an administrator, enter your ID and your password in the screen below.
Then click <OK>.

Fleaze input ID and Paszwond E'

I

* i dyndndstrator level iz required

| ok || Coma |

Figure D-4 ID and Password (Administrator)
5. TOnce you've checked the firmware versions and clicked <Flash>, firmware

flashing will start. See the figures below.
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Y AFUFlash X
Remote Flash Tool for Hermon/aM FW V121
IP: |192.168.12.169 | Orptions
[] Preserve Bootloader
File: |D:".FW".P;MI".K'.-‘DC T-L_130 ima | [ Browse. .. ]
[] Preserve Config Module

Hew firmware verson : 1 30

Current fiomveare version: 1.30 . FW Version |

Figure D-5 Display of Current Firmware Version

¥ AFUFlazh [$_< |
Remaote Flash Tool for Hermon/AM FWW w121
IP: |192.168.12.169 | Optinns

Fresrve Bootloader

File: |D:".FW"=P;MI".K?DC T-L_120.iroa | Browese. .

Fressrve Config Module
Wew firmware version : 1.30
Crrrent fivmweare verson: 1.30 FW Version
statuz: 79 (1,310,720 botes £ 16,777,216 botes )
(1]
Remaining Time: & miniz) 47 wclz) Flash

Figure D-6 Remote Flash #1

71



Supermicro IPMI View User’s Guide

¥ AFFlash r>—<|
Remote Flash Tool for Hermon/AM FW ¥121
IF: \192.153.12.159 | Options

Presrve Bootloader

File: ‘D:'\FW\AMI\K?BC T-L_130.ima. | Browess...

Preserve Config bModule
Wew fivmueane version : 1.30
Current firmware version: 1.30 FW ¥ersion
Statos: 22% (3,801,083 bortes / 16,777,216 botes )
CLLLELEELL L
Femaining Time: 5 mingz) 41 secls) Flazh

Figure D-7 Remote Flash Screen #2

¥ AFTFlash r>—<|
Remote Flash Tool for Hermon/AM FW V191
IF: |192_153_12_159 | Options

Preserve Boofloader

File: |D:'\FW'\AMI'\KTDC T-L_130.1ma | Browse...

Preserve Config Module
Hew firmvware version : 1.30
Current firmware version: 1.30 FW ¥ersion
Status: 519 ¢ 8,585,216 bartes / 16,777,216 bates )
[llllllllllllllllllllllllllll
Eemaining Time: 3 minfz) 35 scls) Flach

Figure D-8 Remote Flash Screen #3

6. When the flashing is complete, the status field displays “Finished.” Click
<Close> to exist this dialog box.
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¥ AFUFlash 3
Remote Flash Tool for Hermon/AM FW ¥121
IP: \192.153.12.159 | Opticns
Preserve BootLoader
File: DAFWAMIETDCT-L 130dma | | B
Preserve Config bModule

Mew firmweare verson : 1,30

Current firmware version: 1.30 FW Fersion

Statnz Finshed . (BMC needs | minnte to restart)

IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII

Figure D-9 Remote Flash Screen #4
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Appendix E: SIM(WA) Firmware
Update

1. Select an SIM(WA) device and select <Update Firmware> in the menu for SIM(WA)
Firmware re-flashing. A dialog box appears.

Confimmation

X

.
A ) Thiz iz SIM{W L) device. Please make sure you have correct firmware for vpdate (* bin)

Figure E-1 Firmware Update

2. Make sure that you have the correct firmware for update, and click <OK>. The
dialog box below appears.

Elash Tool r>_<|

Remote Flash Tool for Hermon/AT FW ¥1.20

IF: \192.158.12.125

|
Fik: | |

Birowse...

Figure E-2 Flash

3. Click <Browse> to select the desired firmware file for remote flashing. It will be
checked to see if it is a valid file before remote flashing starts.

Flash Tool [zl

Remote Flash Tool for Hermon/AT FW ¥ian

IF: ‘192.168.12.125 ‘

File: | DAFW\ATENWESDIL 817 bin '

New finmuare version : 01.15

Figure E-3 Flash
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4. Click <FW Version>. Remote flashing can only be performed by an administrator.

If you are an administrator, enter your ID and password in the dialog box.

Please input IDand Password

2 wen |

* A dmdnistrator level i required

[ ok || concel |

Figure E-4 ID/Password

5. Once you've checked the firmware versions and clicked <Flash>, firmware flashing

Remote Flash Tool for Hermon/AT FW Vizno

will start.

IF: |192.168.12.125 |

File: |D:'\FW'\ATEN\.X8DTL_81?.hin | Browse...

Mew firmware version 0 01.15

Crnrrent firmware version: 01.10

Figure E-5 Firmware Versions

Flash Tool

X]

Remote Flash Tool for Hermon/AT FW Y120

IF: |192.1sa.12.125 |

Fil:: |[DAFWNATENBDTL 817 bin | [ Buows..

Mew firmware verson : 01.15

Crrrent firmware verson: 01.10 FW ¥ersion

Statuz: Uploading...

Figure E-6 Remote Flash #1
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Flash Tool

X)

Remote Flash Tool for Hermon/AT FW Y120

IP: |192.1sa.12.125 |

Fil:: |[DAFWNATENWBDTL 817 bin | [ Buows..

Mew firmware verson : 01.15

Crrrent firmware verson: 01.10 FW ¥ersion

Status: Tpdating...

o T

Flash
Figure E-7 Remote Flash #2
Flash Tool &|
Remote Flash Tool for Hermon/AT FW Y120
P 19216812135 |
File: |D:'\FW'\P.TEN\.X8DTL_81?.hin | Biowse.
Mewe firmsware version : 01.15
Curreint fiomueare version: 01.10 FW ¥ersion
Statnz: Updating...
Flazh

Figure E-8 Remote Flash #3
6. When the flashing is complete, the status field displays “Finished”. Click <Close>
to exit this dialog box.

Flash Tool rX|

Remote Flash Tool for Hermon/AT FW F1.20

IP: |192.168.12.125 |

File: |D:'-FW\A TEMEEDTL_817 bin | Browse...

Hew firmware version 0 01.15

Current firmware version: 01.10 FW Version

Status: Finished

1004

Cloz

Figure E-9 Remote Flash #4
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Appendix F: ASPEED X10

Firmware Update

1. Select an ASPEED BMC device and select <Update Firmware> in the menu for

ASPEED Firmware Re-flashing. The dialog box below appears.

Confirmation &J
.
|0_| This is ASPEED BMC. Please make sure you have correct firmware for update (*.bin,32M size)
v

Figure F-1 Firmware Update

2. Make sure that you have the correct firmware for the update, and click <OK>. The

dialog box below appears.
rFlash Tool [&J“

Remote Flash Tool for Hermon, ASPEEDIAT FW ¥1.30

B 101321770

=

Status: Preserve Config

Figure F-2 Flash

3. Click <Browse> to select the desired firmware file for remote flashing. It will be

checked to see if it is a valid file before remote flashing starts.

Flash Tool lé]

Remote Flash Tool for Hermon ASPEED/AT FW ¥1.30

I 101231770

File: |CASMT_X10_105 bin

Hew firmware werson : 1.5

Status: Preserve Config

Figure F-3 Flash
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4. Click <FW Version>. Remote flashing can only be performed by an administrator.

If you are an administrator, enter your ID and password in the dialog box.

Please input ID and Password lé]

Login ID ADMIN
Passwond L 1 11 ] ]
* b dministrator level is required

’ oK ] [ Cancel ]

Figure F-4 ID/Password

5. Once you've checked the firmware versions and click <Flash>, firmware flashing

=55)

Flash Tool

Remote Flash Tool for Hermon ASPEEDIAT FW ¥1.30

IF 101221770

File: |CASMT_X10_105bin

Hew firmueare verson : 1.5

Crrrent firmware wersion: 01.04

Status: Preserve Config

Figure F-5 Firmware Versions

6. When the flashing is complete, the status field displays “Done". (BMC needs 1

minute to restart.)". Click <Close> to exit this dialog box.

[ Flash Tool lﬂw
Remote Flash Tool for Hermon ASPEED/AT FW V130
I 1101330770
File: |CA8MT_X10_105.bin Browse...
Hew firmueare verson : 1.5
Current firmware wversion: 01.04 FW Version
Statuz: Done. (BMC needs 1 minute to restar) Preserve Config

Cloz

Figure F-6 Remote Flash
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Contacting Supermicro

Headquarters

Address: Super Micro Computer, Inc.

980 Rock Ave.

San Jose, CA 95131 U.S.A.

Tel: +1 (408) 503-8000

Fax: +1 (408) 503-8008

Email: marketing@supermicro.com (General Information)
support@supermicro.com (Technical Support)

Web Site: www.supermicro.com

Europe

Address: Super Micro Computer B.V.

Het Sterrenbeeld 28, 5215 ML

's-Hertogenbosch, The Netherlands

Tel: +31 (0) 73-6400390

Fax: +31 (0) 73-6416525

Email: sales@supermicro.nl (General Information)
support@supermicro.nl (Technical Support)

rma@supermicro.nl (Customer Support)

Asia-Pacific

Address: Super Micro Computer, Inc.
3F., N0.150, Jian 1st Rd., Zhonghe Dist.,
New Taipei City 23511, Taiwan (R.O.C.)
Tel: +886-(2) 8226-3990

Fax: +886-(2) 8226-3992

Web Site: www.supermicro.com.tw

Technical Support:

Email: support@supermicro.com.tw
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